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1. INTRODUCERE 
 
Va multumim ca ati optat pentru serviciul Anyma Online Trading oferit de BRD Groupe 
Société Générale.  
 
Cu Anyma Online Trading puteti executa schimburi valutare la vedere sau la termen, la 
cotatii personalizate oferite de BRD.  
 
Utilizand acest serviciu beneficiati de siguranta maxima, BRD implementand in acest scop 
sisteme performante de securitate dar care in acelasi timp ofera si mobilitatea de care aveti 
nevoie.  

 
Utilizarea platformei este intuitiva, toate operatiunile se desfasoara in cativa pasi simpli, iar 
posibilitatile de personalizare sunt virtual nelimitate.  

 
Acest ghid detaliat va ajuta sa descoperiti cea mai mare parte din functionalitatile 
serviciului. 
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2. CONDITII DE UTILIZARE  
  
Aplicatia este disponibila pe orice echipament PC avand sistem de operare Windows (versiunile 
Vista, Windows 7, Windows 8, Windows 10) si poate fi descarcata si instalata gratuit de la 
adresa:   
 
https://www.brd.ro/_files/other/InstallInfront.exe   
 

Serviciul necesita acces la Internet, indiferent de modul de conectare (retea mobila, retea 
wireless).   
 
Dupa descarcarea fisierului executabil si lansarea acestuia (prin selectarea optiunii „Run”) va 
aparea urmatorul ecran:   

 
 

In ecranul de mai jos se va selecta Next : 

 
Pentru a putea continua va trebui sa certificati ca sunteti de acord cu termenii si conditiile impuse 

https://www.brd.ro/_files/other/InstallInfront.exe
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de furnizorul Infront : 

 
 
In ecranul urmator se va selecta optiunea de instalare personalizata (Custom), in care puteti 
alege locatia de pe hard-disk pentru aplicatie sau optiunea implicita (Install Now) :  
 

 
Daca programul se va instala si nu vor aparea probleme in timpul instalarii, se va afisa mesajul: 
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Acesta reprezinta semnalul ca programul a fost instalat si este gata de rulare. 

Prin apasarea iconitei  (shortcut-ul aplicatiei creat pe desktop) se va lansa aplicatia: 
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3. ACTIVAREA SERVICIULUI  

3.1. ACTIVAREA FUNCTIONALITATILLOR DE CONSULTARE A COTATIILOR DE 

PIATA SI A STIRILOR  
  

Aceasta functionalitate necesita o autentificare statica.  
  
La prima pornire a aplicatiei va trebui sa introduceti datele de conectare (user si parola) primite 
in email-ul de confirmare deschidere cont:  

  
 
 

Dupa introducerea acestor date aplicatia este gata de utilizare pentru vizualizarea de cotatii si 
stiri.   
  
NOTA: In cazul in care accesul la internet se face printr-un server proxy, puteti seta programul 
sa foloseasca un astfel de server mergand pe tab-ul Proxy (din Advanced Setings). Datele de 
conectare la serverul proxy le puteti obtine de la furnizorul dumneavoastra de internet sau de la 
administratorul de retea.  
 

Autentificarea statica 
(user/parola primite prin e-mail) 



   

ANYMA ONLINE TRADING / GHID DE UTILIZARE MODUL FX        Pagina  9 / 34 

 

 
 

Dupa introducerea  datelor de conectare (user si parola) este necesar sa inchideti aplicatia. La 
redeschidere, odata cu folosirea noilor date de conectare introduse, veti primi drepturile 
specifice conform contractului. Aplicatia retine datele de autentificare si la urmatoarea pornire 
nu le mai solicita.  
Schimbarea parolei statice se realizeaza din meniu sectiunea My Profile/Account/Change 
password, la final fiind necesar un restart al aplicatiei.  
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Aplicatia este disponibila si in limba romana. Initial se instaleaza in limba engleza.  
Schimbarea setarilor pentru limba se poate face in meniul Tools/Advanced Settings/User 

Interface/Regional. Dupa salvare si repornirea aplicatiei, ecranele se vor deschide cu meniurile in 
limba selectata. 
 

 
 

Va recomandam sa instalati si una din aplicatiile de antivirus disponibile pentru Windows PC, 
pentru protectia impotriva furtului de date, impotriva accesului neautorizat, etc.  
 

Userul si parola se pot modifica ulterior accesand sub-meniul Tools/Advanced Setings /Login 
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3.2. ACTIVAREA FUNCTIONALITATILOR DE TRANZACTIONARE SI 

CONSULTAREA PORTOFOLIILOR   
Pentru activarea acestor functionalitati aveti nevoie de un dispozitiv de tip DIGIPASS.  
  
Daca ati optat pentru un dispozitiv de tip token DP 260 puteti sa nu luati in considerare 
pargaraful urmator.  
  
Daca ati optat pentru varianta software a acestui dispozitiv, va trebui sa urmati pasii de mai jos 
in functie de dispozitivul ales: Smartphone cu sistem de operare iOS, Android sau Windows 
Mobile (cel putin versiunea 7).  
  

Pas 1: Receptionarea elementelor de securitate din partea bancii:   
- Datele de identificare (Serial Number, Activation Code, Username) transmise prin email dupa 
semnarea contractului.   
- Codul de activare (Activation Code) transmis prin SMS direct pe telefonul mobil specificat in 
Cererea de Utilizare   
 
Pas 2: Descarcati gratuit aplicatia specifica telefonului sau tabletei pe care o utilizati. In functie 
de sistemul de operare utilizat de telefonul tau, aplicatia se descarca din:  
- Google Play Store pentru sistemul de operare Android – aplicatia BRD Anyma Digipass   
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- AppStore pentru sistemul de operare iOS - aplicatia BRD Anyma Digipass  
- Windows Store pentru sistemul de operare Windows Mobile – aplicatia BRD Anyma Digipass  
 
Pas 3: Instalati aplicatia   
Pas 4: Acceptati termenii si conditiile BRD  
Pas 5: Introduceti elementele de securitate: Serial Number, Activation Code, Username, Parola 
locala  
  
Codurile de securitate devin invalide daca sunt introduse gresit de 5 ori. In acest caz este 
necesar sa contactati Banca pentru a va fi atribuite noi elemente de securitate.  
  
Informatiile de pe device-ul mobil trebuie sa fie sincronizate cu serverul Digipass. Daca 
activarea esueaza contactati administratorii Anyma la adresa anymafx@brd.ro sau telefon 021 
301 4336.  
  

NOTA: Un utilizator poate  opta pentru o singura varianta de dispozitiv DIGIPASS.  
 
 

 

4. ACCESAREA SI SECURITATEA SERVICIULUI  
  
Elementele de autentificare sunt confidentiale si trebuie sa fie cunoscute doar de 
dumneavoastra. Acestea nu trebuie comunicate verbal, prin telefon, prin e-mail sau formular 
niciunei alte persoane, chiar daca persoanele respective sunt reprezentanti BRD - Groupe 
Société Générale sau orice alta autoritate.   
  

Metoda principala de securitate pentru functionalitatile de tranzactionare si consultare 
portofolii este un token Vasco Digipass. Acesta este o solutie avansata de securizare a accesarii 
serviciului si a semnarii tranzactiilor. Simplu si avantajos, cu tokenul hardware sau mobil 
generati parole si semnati tranzactii direct in cadrul aplicatiei online trading.   
 
 
 
 
 
 
 
 
 

mailto:anymafx@brd.ro
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5. UTILIZARE APLICATIE 

5.1. PAGINA DE START  
  
La prima deschidere a aplicatiei, dupa introducerea parolei statice primita pe email (vezi 
capitolul 3.1), vi se va prezenta fereastra standard (daca raspunsul la intrebarea daca doriti 
ecranul default este Da) concomitent cu o a doua si ultima autentificare, respectiv parola 
dinamica generata cu Digipas. Pentru folosirea  Digipass-ului vezi capitolul 7.  
 

 
 
 

5.2. PERSONALIZARE ECRANE COTATII PIATA VALUTARA  
 
Fereastra FX Spots (Tranzactii valutare Spot sau Today) – reprezinta o fereastra in care se pot 
configura perechile de valute pentru care dorim afisarea cotatiilor spot sau today.   
Fereastra FX Forward (Tranzactii valutare la termen) – reprezinta o fereasta in care se pot 
configura perechile de valute pentru care dorim afisarea cotatiilor la termen pentru diferite 
scadente. Aceasta functionalitate este disponibila doar daca in Cererea de Utilizare ati bifat 
produsul Forward si aveti semnat contractul cadru IFD.   

Autentificarea 
dinamica (Digipass 
mobile sau fizic) 
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Pentru ambelele tipuri de cotatii alegerea perechilor de valute se face in mod similar   
File/Show All/FX Spots sau FX Fowards  
 
 

 
 
 

 
 
 
Apasand + in aceasta fereastra anterioara (Add currency pairs) se va deschide ecranul: 
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Acesta permite selectarea perechilor de valute dorite.  Apasand « Add », acea pereche de 
valute va fi selectata, putand fi vizualizata oricand in ecranul principal. Cand ati finalizat setarile, 
confirmati cu OK.  
Daca ati ales cotatii Today se va obtine o fereasta ca in exemplul de mai jos:  
 

 
 
Pentru a obtine cotatii Spot trebuie accesat din meniul ecranului Display mode>Today sau Spot. 

 
 

 
 
  Fiecare caseta din tabela contine:  
- Numele perechilor de valute  
- Un buton pe care, apasand, se poate vizualiza un grafic al evolutiei perechii de valute selectata  

Afisare cotatii Spot 

sau Today 
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- High/Low – cel mai inalt/jos nivel al cotatiei in ziua respectiva  
- Pretul de vanzare/cumparare (sell/buy)  
- Indicator care arata schimbarile pozitive/negative ale pretului  
 

 
 
Daca ati ales cotatii Forward se va obtine o fereastra ca in exemplul de mai jos, care prezinta 
cotatiile pentru perechile de valute pe care le-ati selectat:  
 

 
 
 
Aranjarea ferestrelor in spatiul de lucru se poate face prin repozitionare si redimensionare in 
functie de preferinte.   
Prin apasarea butonului „+” se pot adauga oricand noi perechi de valute, atat in fereastra de 
Spot (Today), cat si in cea de Forward.  
La sfarsit se salveaza  setarile apasand Ctrl+S (Save).  
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Aplicatia permite definirea mai multor ecrane (workspaces) de informatii prin efectuarea unui  
Click pe simbolul + ( Add blank desktop… ) sau New Desktop din bara de jos. 
Tot prin efectuarea unui click-dreapta pe numele ecranului se poate schimba numele acestuia  
sau se poate sterge:  
 

 
  

  
  

Salvarea setarilor se 
realizeaza prin Save (Ctrl+S) 
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Mutarea dintr-un ecran in altul se face apasand pe tab-ul cu numele ecranului din partea  
de jos a ecranului.  
Un ecran nou nu contine initial ferestre cu date. Pentru a afisa informatii este necesar sa  
deschideti din meniuri informatiile de care aveti nevoie.  
  
Veti gasi mai multe ecrane predefinite pe care le puteti incarca automat in 
Meniu>File>Workspace>New Desktop (sectiunea Provider):  
 

 
 

 
 

5.3. PERSONALIZARE ECRANE INFORMATIVE  
Odata pornita aplicatia, aceasta prezinta utilizatorului un ecran cu o combinatie de 4 ferestre 
informative:  
- Cotatii  
- Stiri  
- Grafice  
- Blotter   
 
Ferestre aditionale se pot deschide din diferite meniuri:  

5.3.1. COTATII DE PIATA   

  

Se acceseaza meniul Tools/Market:   
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Fereastra de cotatii reprezinta o lista de preturi ale instrumentelor de pe piata aleasa. 
 

5.3.2. STIRI  

Se acceseaza meniul File/News  
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Fereastra de stiri prezinta stiri din diverse surse configurabile.  Se bifeaza sursele dorite si se 
apasa butonul „OK” ca in imaginea urmatoare : 

 
 
In momentul in care se va apasa butonul OK dupa selectare, se va deschide ecranul mixed 
news : 

 
 

5.3.3. GRAFICE   

  
Click dreapta pe simbolul dorit si apoi selectare Intraday Chart / Historical Chart  
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Fereastra de grafice poate fi personalizata cu elemente de analiza tehnica, disponibile in partea 
de sus a ferestrei.   
  
Cateva exemple se gasesc in ecranul de mai jos. Lista completa de indicatori se obtine prin 
optiunea Technicals / More. 
 

 
 



   

ANYMA ONLINE TRADING / GHID DE UTILIZARE MODUL FX        Pagina  22 / 34 

 

 

6. FUNCTIONALITATI DE TRANZACTIONARE SI CONSULTARE ISTORIC 

TRANZACTII  

6.1. AUTENTIFICARE  
  

Pentru a putea accesa istoricul tranzactiilor dumneavoastra sau pentru a putea introduce 
tranzactii este necesar sa apasati butonul trading din meniul Tools> Trading   
  
Inainte de a afisa informatii in fereastra de tranzactionare, aplicatia va solicita numele si parola 
de BRD Trading/Tranzactionare :  
 

 
  
  
  

Login – introduceti numele de utilizator de trading primit de la BRD prin e-mail  
Password - valoarea afisata de catre dispozitivul Digipass fizic/mobil (pentru instructiuni privind 
utilizarea digipass-ului va rugam sa cititi capitolul 7. Utilizare Digipass).  
  
ATENTIE ! Daca inchideti fereastra trading, programul va solicita din nou sa va autentificati in 
momentul in care doriti sa introduceti un ordin sau cand redeschideti fereastra de trading. 
 

 
 
 
 

Autentificarea dinamica 
(Digipass Mobile sau fizic) 
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6.2. FUNCTIONALITATEA DE TRANZACTIONARE PIATA VALUTARA  
  

6.2.1. INCHEIEREA UNEI TRANZACTII CU DATA DECONTARE TODAY/TOMORROW/SPOT  
Pentru a solicita o cotatie cu data de decontare today/tomorrow/spot se apasa pe perechea de 
valute pe care doriti sa o tranzactionati din ecranele configurate pentru prezentarea cotatiilor.  
 

 
  

In urma acestei actiuni se va deschide unul din urmatoarele ecrane in functie de optiunea 
aleasa  („Buy” daca doriti sa cumparati prima valuta sau „Sell” doriti sa vindeti prima valuta):  
  

 
 

 - Se alege « value date » (data de decontare) dorita  
- Se completeaza suma (fie in valuta 1, fie in valuta 2) - In cazul in care considerati necesar, 
puteti folosi abrevierile «K» pentru mii si «M» pentru milioane.  
- Campul « Comment » este optional   
- In cazul in care sunteti utilizator autorizat sa tranzactionati pentru mai multe companii, alegeti 
compania pentru care doriti sa faceti schimbul valutar prin selectarea din lista derulanta a 
campului « Portfolio ».   
- Campul « rate » va afisa cotatia informativa din momentul respectiv  
- Apasati « Submit »  pentru a cere o cotatie ferma.  
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Dupa apasarea butonului “Submit”, va aparea urmatoarea fereastra in care se cere acordul 
pentru efectuarea tranzactiei, “Accept” - de acord cu tranzactia sau “Reject” pentru respingere. 
  

 
 
 
Dupa ce apasati « Accept » se va deschide o fereastra «View deal» care va confirma tranzactia.  

 
 
Aceasta confirmare poate fi tiparita atat imediat cat si ulterior (prin accesarea acesteia din lista 
de tranzactii).  
  

In cazul in care ati optat pentru decontarea automata a tranzactiilor in Cererea de Utilizare, 
dupa inregistrarea tranzactiei in cont, veti primi un e-mail de confirmare.  
In cazul in care nu ati optat pentru decontarea automata a tranzactiilor in Cererea de Utilizare, 
imediat dupa incheierea tranzactiei in Anyma Online Trading este necesar sa transmiteti un 
ordin de schimb valutar catre Banca. 
 

Confirmarea cotatiei 
prin apasarea 
butonului ‘Accept’ 
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6.2.2. INCHEIEREA UNEI TRANZACTII CU DATA DE DECONTARE FORWARD  
  
Pentru a solicita o cotatie cu data de decontare forward, se apasa pe perechea de valute pe 
care doriti sa o tranzactionati din ecranele configurate pentru prezentarea cotatiilor.  
 

 
  

In urma aceste actiuni se va deschide urmatorul ecran: 
 

 
 
  

- Se alege « value date » (data de decontare) dorita  
- Se completeaza suma (fie in valuta 1, fie in valuta 2) - In cazul in care considerati necesar, 
puteti folosi abrevierile «K» pentru mii si «M» pentru milioane.  
- Campul « Comment » este optional   
- In cazul in care sunteti utilizator autorizat sa tranzactionati pentru mai multe companii, alegeti 
compania pentru care doriti sa faceti schimbul valutar, prin selectarea din lista derulanta a 
campului « Portfolio ».   
- Campul « Rate » va afisa cotatia informativa din momentul respectiv  
- In cazul in care doriti sa tranzactionati un forward fara livrare (NDF), bifati « NDF » si apoi 
selectati din lista derulanta cotatia fata de care se va faca decontarea la scadenta.    
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Tranzactionarea forward de tip NDF presupune vanzarea sau cumparea cu angajament de 
decontare doar a diferentei intre cursul agreat la momentul contractarii si cursul de fixing. Se 
poate alege, la incheierea tranzactiei, ca alternativa pentru cursul de fixing, folosit la scadenta 
instrumentului, una din cele 3 optiuni :  
 o Cursul de piata (Market)  

 o Cursul BNR (BNR)  
 o Cursul ECB (ECB)  
Determinarea sumei de decontat se va face cu 2 zile lucratoare inainte de scadenta 
tranzactiei.  
Apasati « Submit »  pentru a cere o cotatie ferma.  
Dupa apasarea butonului « Submit » va aparea urmatoarea fereastra :  

 
 
In cazul in care doriti sa confirmati tranzactia la cotatia primita, apasati « Accept ». Daca nu 
doriti sa confirmati tranzactia, apasati « Reject ».   
Dupa ce apasati « Accept » se va deschide o fereastra «View deal» care va confirma 
tranzactia. 
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Aceasta confirmare poate fi tiparita atat imediat cat si ulterior (prin accesarea acesteia din 
lista de tranzactii).  
  

 In cazul in care ati optat pentru decontarea automata a tranzactiilor in Cererea de Utilizare, 
dupa inregistrarea tranzactiei in cont veti primi un e-mail de confirmare.  
In cazul in care nu ati optat pentru decontare automata a tranzactiilor in Cererea de Utilizare, 
imediat dupa incheierea tranzactiei in Anyma Online Trading este necesar sa transmiteti un 
ordin de schimb valutar catre Banca.  
 

6.3. FUNCTIONALITATEA DE CONSULTARE PORTOFOLII PIATA VALUTARA  
  

Tranzactiile incheiate si confirmate pot fi vizualizate in fereastra de tranzactionare (Trading 
Window), la aceasta fereastra ajungand prin apasarea butonului File > Trading:  
 

 
   

Dublu-click pe oricare tranzactie va afisa fereastra cu datele tranzactiei. Aceasta poate fi 
tiparita.  
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7. UTILIZARE DIGIPASS VASCO  

7.1. DISPOZITIV DP 260  

  

Pentru a va autentifica folosind Digipass-ul Vasco de tip token este necesar sa efectuati 
urmatoarele  
actiuni :  
  

- Porniti digipass-ul DP 260 apasand pe butonul sageata situat in partea dreapta jos a tastaturii 
(fig 1)  
- Introduceti codul PIN al Digipass-ului setat odata cu prima activare a acestuia (fig 2)  
- Apasati pe butonul « 1 » pentru a obtine parola de conectare la fereastra de tranzactionare 
(fig 3)  
- Introduceti in campul « parola », din fereastra de login, codul furnizat de Digipass (fig 4)  
 

                   
 
 Fig.1      Fig.2         Fig.3           Fig.4   
 
 
 

Pentru a obtine o noua parola dupa ce ati obtinut o parola va trebui sa apasati pe butonul « < »  
si apoi pe butonul « 1 »  
 

7.2. DISPOZITIV SOFTWARE  
Pentru a folosi Digipass pentru Mobil este necesar sa efectuati urmatoarele actiuni:  
1) Introduceti codul PIN (configurat la prima activare a aplicatiei)  
2) Va aparea ecranul cu parola OTP generata  
3) Pentru a genera o noua parola, folositi butonul back (al mobilului) si accesati fereastra OTP  
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In caz de dificultati, folositi fereastra Settings pentru a obtine datele necesare administratorilor  
Anyma   

         
 
 

 
   

8. TARIFE  
  
Pentru utilizarea serviciului Anyma Online Trading nu se percep comisioane.   
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9. LIMITE  
  
Ca masura suplimentara de securitate, serviciul Anyma Online Trading functioneaza pe baza mai 
multor tipuri de limite.  
  
In cazul instrumentului schimb valutar la termen (Fx Forward), limita este data de valoarea liniei 
de expunere derivate care v-a fost acordata de banca.  
Suma minima a unei tranzactii initiate prin intermediul Modulului Schimburi Valutare al Anyma 
Online Trading este de 5000 EUR si echivalentul in alte valute.  
  

10. ACTUALIZAREA DATELOR  
  
Actualizarea informatiilor despre starea conturilor este realizata in zilele lucratoare.   
Limitele de tranzactionare Fx forward sunt actualizate online in cursul zilei, imediat dupa 
efectuarea de tranzactii pe acest instrument.  
  
  

11. TRANSMITEREA DATELOR   
   
Tranzactiile sunt executate in timp real in cadrul programului de lucru;  
Nu se pot incheia tranzactii pe piata valutara in zilele lucratoare in afara intervalului 09.00-
17.00 sau in zilele nelucratoare;  
  
Actualizarea informatiilor se realizeaza in timp real.   
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12. INTREBARI FRECVENTE  
  

12.1.  GENERAL  
  

1. Ce este Anyma Online Trading Modulul FX?  
 
Anyma Online Trading Modulul FX este un serviciu de Home Banking ce va permite sa 
tranzactionati online pe piata valutara la vedere sau la termen prin intermediul BRD.  
  
2. Ce pot face cu Anyma Online Trading Modulul FX? Cu ce imi este de folos Anyma Online 
Trading Modulul FX?  
 
Anyma Online Trading va permite sa:  
- Consultati cotatiile de schimb valutar oferite de BRD pentru tranzactii la vedere si la termen   
- Consultati stiri despre pietele financiare pe care doriti sa actionati  
- Realizati analize tehnice sofisticate pe istoricul cotatiilor instrumentelor financiare dorite  
- Efectuati schimburi valutare la vedere sau la termen intre conturile administrate de 
dumneavoastra  
- Efectuati decontarea automata a tuturor tranzactiilor de schimb valutar daca alegeti acest 
lucru (fara sa mai fie nevoie de confirmarea prin sucursala)  
- Consultati istoricul de cereri de cotatie si tranzactii de schimb valutar  
- Tipariti confirmarile de tranzactie   
  
3. Ce este un utilizator autorizat ?  
 
In cadrul documentului Cererea de utilizare a  serviciului Anyma Online Trading Modulul FX, 
aveti posibilitatea de a desemna unul sau mai multi utilizatori autorizati care vor avea acces la 
conturile asociate schimburilor valutare prin intermediul aplicatiei. In cazul clientilor persoane 
fizice, titularul contractului se identifica cu utilizatorul autorizat, neexistand posibilitatea de a 
defini utilizatori autorizati suplimentari.   
  
4. Cum obtin ajutor ? Cine ma poate ajuta ?  
 
Pentru a te ajuta in utilizarea Anyma Online Trading iti oferim urmatoarele alternative:  
- Ghidul de utilizator pentru accesul la serviciu  
- Anyma FX helpdesk  - de luni pana vineri, intre orele 9.00 – 17.00 la numerele de telefon 021 
301 43 36 sau prin email la adresa anymafx@brd.ro  

mailto:anymafx@brd.ro
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- In aplicatie, prin apasarea tastei F1, beneficiati de un serviciu de help interactiv care va poate 
oferi detalii despre functionalitatile aplicatiei  
 

12.2. ACCESARE  
  

1. Cum pot subscrie la Anyma Online Trading Modulul FX ?  
 
Pentru a putea subscrie la Anyma FX este necesar sa semnati :  
  
 o Conditii Generale pentru utilizarea sistemului Anyma Online Trading Modulul FX  

 o Cererea de Utilizare a serviciului Anyma Online Trading Modulul FX  
 
  
Elementele de securitate care permit accesul in aplicatie vor fi trimise catre fiecare utilizator 
utilizandu-se datele de contact comunicate in Cererea de mai sus.  
  
2. Cum pot accesa Anyma Online Trading Modulul FX?  
 
Accesarea serviciului Anyma Online Trading Modulul FX se face pe baza elementelor de 
securitate. In functie de tipul de Digipass pentru care ati optat, va rugam sa consultati ghidul 
detaliat pentru a identifica toate elementele de securitate necesare pentru functionalitatile 
dorite.   
  
3. De ce trebuie introdus codul Digipass de fiecare data cand solicit o cotatie?  
 
Este posibila introducerea codulul de digipas o singura data intr-o sesiune de tranzactionare 
daca deschideti si pastrati deschisa fereasta de portofoliu (capitolul 6.3 din acest ghid).  
  

12.3. SIGURANTA  
  

1. Este Anyma Online Trading un serviciu sigur ?  
 
Anyma Online Trading utilizeaza cele mai moderne sisteme de securitate. Comunicatia este 
criptata, iar autentificarea utilizeaza un dispozitiv Digipass. Acesta este o solutie avansata de 
securizare a accesarii serviciului si a semnarii tranzactiilor ce utilizeaza un proces de 
autentificare bazat pe doi factori. De asemenea, pentru activarea aplicatiei se utilizeaza coduri 
unice transmise separat prin email si prin SMS pentru a preveni orice tentativa de frauda.  
De asemenea, recomandam ca masuri suplimentare de securitate:  
- pastrarea secreta a codului de acces in aplicatie si schimbarea acestuia daca exista suspiciunea 
ca este cunoscut de alte persoane  
- protejarea fizica a telefonului folosit pentru generarea parolei sau a tokenului DP 260 prin 
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limitarea utilizarii acestuia in spatii publice sau lasarea acestuia nesupravegheat  
 
    
2. Ce pot face ca sa ma protejez de virusi si spyware ?  
  
Va recomandam sa instalati un program de tip antivirus pentru a proteja integritatea datelor 
transmise de catre calculatorul folosit pentru accesarea aplicatiei.  
  
3. Cum pot preveni tentativele de frauda ?  
 
Nu raspundeti niciodata la mesaje e-mail sau SMS care cer informatii personale sau financiare. 
Va rugam sa contactati Banca in cel mai scurt timp, in cazul in care primiti astfel de mesaje (0 
800 803 803 sau vocalis@brd.ro). De asemenea, elementele de securitate nu trebuie 
comunicate altor persoane sau personalului bancii. Este imperativ ca aceste elemente de 
securitate sa fie cunoscute numai de catre dumneavoastra.  
In cazul in care aveti suspiciuni de incidente frauduloase va rugam sa contactati banca.  
  

12.4. TEHNIC  
  

1. De pe ce dispozitive poate fi accesat Anyma Online Trading?  
  
Aplicatia dedicata poate fi accesata de pe orice computer care ruleaza unul din urmatoarele 
sisteme de operare:  Windows Vista, Windows 7, Windows 8, Windows 10   
  
Pentru computere care ruleaza alte sisteme de operare este posibila instalarea Anyma intr-o 
masina virtuala Windows (de exemplu aplicatia Parallels , VMWare Fusion 7, Virtual Box)  
  
2. De pe ce browser poate fi accesat Anyma Online Trading?  
  
Anyma Online Trading nu functioneaza prin broswer. Aplicatia necesita instalarea locala pe 
computerul personal.  
  
3. Este necesara conexiune la Internet pentru utilizarea Anyma Online Trading?  
 
 Aplicatia dedicata necesita acces la Internet, indiferent de tipul conexiunii (retea mobila, retea 
wireless).   
  
  

mailto:vocalis@brd.ro
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12.5. FUNCTIONALITATI  
  

1. Ce conturi se pot vizualiza ?  
  
Nu se poate vizualiza situatia conturilor implicate in operatiunile de schimb valutar  
 
  
2. Pot efectua tranzactii noaptea sau in weekend ?  
  
Cererile de cotatii pe piata valutara pot fi introduse doar in intervalul orar 09.00-17.00. Orice 
astfel de cereri in afara intervalului vor fi ignorate si nu se vor executa automat in urmatoarea zi 
lucratoare.  
  
3. Pot transfera bani catre alte conturi din Romania sau din strainatate prin intermediul Anyma 
Online Trading Modulul FX?  
 
Aplicatia efectueaza doar decontari aferente tranzactiilor valutare initiate prin Anyma Online 
Trading Modulul FX intre conturile specificate in Cererea de utilizare a sistemului Anyma Online 
Trading modulul Fx, daca asemenea conturi optionale au fost specificate. In cazul lipsei lor din 
Cerere, va trebui sa contactati unitatea Bancii pentru a efectua decontarea pe baza tranzactiei 
incheiate prin intermediul sistemului Anyma Online Trading  
  
4. Care sunt limitele de tranzactionare ?  
 
In cazul instrumentului schimb valutar la termen (Fx Forward), limita este data de valoarea liniei 
de expunere derivate care v-a fost acordata de banca.  
   
5. Care este suma minima a unei tranzactii initiate prin intermediul Anyma Online Trading 
Modulul FX?  
  
5,000 EUR sau echivalentul in alte valute 


